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4.14 PREFERENCES MENU 

1. 4.14.1  about preferences 

2. 4.14.2  general settings 
1. 4.14.2.1    project files 

2. 4.14.2.2    colors and fonts 
3. 4.14.2.3    launch application 

4. 4.14.2.4    launch url 
5. 4.14.2.5    backup settings 

6. 4.14.2.6    checksum calculation 
7. 4.14.2.7    dos directory 

8. 4.14.2.8    footnotes 

3. 4.14.3  project settings 
1. 4.14.3.1    project title 

2. 4.14.3.2    user data 
3. 4.14.3.3    sequence format 

4. 4.14.3.4    color patterns, nucleotide 
5. 4.14.3.5    color patterns, protein 

6. 4.14.3.6    color patterns, primer 
7. 4.14.3.7    header 

8. 4.14.3.8    trace file folder 
9. 4.14.3.9    global timeout 

10. 4.14.3.10    project blast settings 
11. 4.14.3.11    backup settings 

4. 4.14.4  form behavior settings 
5. 4.14.5  description line format settings 

1. 4.14.5.1    format settings 

2. 4.14.5.2    left-trim lines 
3. 4.14.5.3    right-trim lines 

4. 4.14.5.4    replace lines 
6. 4.14.6  chromatogram import settings 

1. 4.14.6.1    fixed schemes 
2. 4.14.6.2    options for basecalling 

3. 4.14.6.3    trimming raw sequences 
4. 4.14.6.4    n-threshold 

5. 4.14.6.5    gap-quality 
7. 4.14.7  ncbi settings, firewall 

8. 4.14.8  internet connection and server settings 
1. 4.14.8.1    internet connection 

2. 4.14.8.2    ncbi resources 
9. 4.14.9  compose search data file 

10. 4.14.10  log- and ini-file viewer 

11. 4.14.11  application color coding 
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4.14.1 about preferences 

SEQtools contains various options for controlling program behavior 
grouped under the Preferences menu of the main editor form.  
 

 

When you exit SEQtools, the settings are saved in an ini-file located in the 
application folder as a plain text file. Each instance of SEQtools gets its 

own ini-file making it possible to set different preferences for different 
instances of SEQtools. For example you can set different sequence color 

pattern and background color for instances for handling nucleotide, 

protein and primer sequences. Read more about command line options in 
section 3.3 Features of the manual. 

 
It is recommended that you go through and set program preferences as 

you prefer the first time you launch SEQtools after installing the program. 
Pay special attention to settings for internet connection and the NCBI ini-

file. The latter setting varies depending on your operating system. 
(Windows2000 or Windows XP) 

 
The different groups of preferences are described in some detail below. 

Quite a number of user questions relates to problems caused by incorrect 
preference settings so please read this section carefully. 

4.14.2 general settings 

The eight tabs of the general settings form are displayed below. In most 
cases the effect of changing these settings are self explanatory. 

 
4.14.2.1 Project Files - Enables auto-saving plp and psp files each time 

a project is saved. This implies that you can re-open the project either 
with the sequences originally loaded into the project (*.plp) or with the 

files included  

after editing and saving the project (*.psp). 
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4.14.2.2 Colors and fonts - SEQtools requires that you use fonts with 

fixed character-spacing such as Courier New or Monospace (included in 
the SEQtools setup file). Using fonts with variable character width will 

cause the sequence to be distorted when displayed in the editor and in 
the various sequence lists. In most cases, however, SEQtools uses hard 

coded font which cannot be changes by the user. 

 

 
 

4.14.2.3 Launch Application - This tab allows you to populate the 
Launch menu of the main editor with up to five applications which will be 

launched by clicking the menu item. To add an application to the list place 
the cursor on the line where you wish the application to appear. Click 

Browse and navigate to the exe-file of the application be to included. 
Clicking the exe-file places the full path in the left field and the title of the 

exe-file in the right. Edit the title of the exe-file if you wish. 
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4.14.2.4 Launch URL - On this tab you can edit the default list of web 
resources: Type the url of the website in the left text field and the title of 

the site in the right field. Maximum number of burls is 10. URL including 
the word NCBI will be identified by an NCBI icon in the menu item, other 

url with a globe. 

 

 
 

4.14.2.5 Backup Settings - Setting the interval between timed backups 
to a positive value specifying the number of minutes between auto-

backups activates the auto-backup function. It is not recommended to use 
this function when you are working with large projects (> 300 

sequences). SEQtools will notify you if the size of the projects exceeds 
300 and offer to turn off auto-backup. 

 

Note that the batch blast function - which may run over several days - 
has a separate function for timed saving each results to avoid loss of data 

in case of power failure during the batch job. This tab is also included in 
the Project Settings form. 
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4.14.2.6 Checksum Calculation - This tab controls the checksum 
function. You may gain some speed improvement by turning this function 

off. 
 

 
 

4.14.2.7 DOS Directory - By default the special directory for the various 
external programs used in SEQtools to perform certain tasks is the one 

given in the tab below. It is possible - but not recommended - to change 
this path. I have not tested the effect of placing the dos folder on a 

different drive and any experiments is at your own risk. 
 

If you change the path SEQtools moves the content to the new 
destination when you click Accept. 
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4.14.2.8 Footnotes - In some cases it may be convenient to include a 
footer when you save a sequence file. 

 

 

4.14.3 project settings 

The settings included in this form affect various aspects of the current 
sequence.  . 

 
 

4.14.3.1 Project Titles - This tab is displayed before loading of 
sequences into the project commences. It furthermore includes a 

checkbox activating validation of sequences while loading. This option 
which is only relevant when you are loading non-SEQtools formatted 

sequences slows the loading process somewhat down. 
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4.14.3.2 User Data - This tab enables you to personalize your project by 

entering your name and e-mail address. 
 

 
 

4.14.3.3 Project Files - The tab allows you to set the display 
preferences for sequence formatting, i.e., whether or not to use upper, 

lower or both cases; to allow spaces in the displayed sequence and to set 

line and block length and line spacing. 
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4.14.3.4 Color Patterns, nucleotide - You can change the color of the 

nucleotides in nucleotide sequences. 
 

 
 
 

4.14.3.5 Color Patterns, protein - You can change the color of 
individual residues in protein sequences with the options included in this 

tab. Note you can selectively highlight amino acids according to their 
properties with the Basic, Hydrophilic, Acidic and Hydrophobic options. 
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4.14.3.6 Color Patterns, primer - You can change the color of 

individual residues of primer sequences with the options included in this 
tab. Note that you can selectively highlight degenerate positions in the 

sequence with the IUB = Red option. 
 

 
 
4.14.3.7 Header - Note that the composition of the sequence header is 

controlled by a separate set of quite extensive options which allows you to 
precisely select which part of the total sequence annotation you which to 

include in the displayed header. 
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4.14.3.8 Trace File Folder - This tab allows you to set the path to the 
folder containing the chromatograms from which sequences in the project 

are derived.  The path is automatically set to that of imported/basecalled 
chromatograms (=trace files) when they are loaded. If, however, you 

import chromatograms located in different folders it is necessary to set 
the path to the folder containing the underlying trace files. Obviously it is 

preferable to place all trace files to be included in a project in the same 

folder. 
 

 
 

 
4.14.3.9 Global Timeout - SEQtools uses a number of external 

programs running under the dos operating system. To do this SEQtools 
creates a "memory space" to hold the process and monitors the process 

to detect when it ends, i.e., when the task is completed. If something 

goes wrong and the external program fails to issue the completed signal 
the process will run for ever unless a timeout is set to kill the process if 

no response is received within a certain period of time.  
 

If everything works as it should the timeout value has no effect as long as 
it is sufficiently large to allow external programs to complete. If, on the 
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other hand, the problem is temporary, a long time out value may allow 

the halted process to resume and run to completion. You need to 
experiment to find the optimal value. Sixty seconds works fine in most 

cases. 
 

 
 

4.14.3.10 Project Blast Settings - Pressing <F5> will create a local 
database containing all sequences on the project and perform a blast 

search on this database, i.e., perform a Project Blast. The result of this 

project blast search is displayed in the sequence list in the right hand 
panel of the main editor (on a light blue background). 

 
The settings in this tab controls the number of matches to display and an 

expect value cutoff. Setting the maximum number of matches to zero 
turns off this function (which there is no reason to do). 

 

 
 

4.14.3.11 Backup Settings - Setting the interval between timed 
backups to a positive value specifying the number of minutes between 

auto-backups activates the auto-backup function. It is not recommended 
to use this function when you are working with large projects (> 300 

sequences). SEQtools will notify you if the size of the projects exceeds 
300 and offer to turn off auto-backup. 
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Note that the batch blast function - which may run over several days - 

has a separate function for timed saving search results to avoid loss of 
data in case of power failure during the batch job. Note that a Backup 

Settings tab is also included in the General Settings form. 
 

 

4.14.4 form behavior settings 

SEQtools uses separate forms for most tasks. This often results in the 
screen being crowded with forms - the one you which to use in most case 
being hidden behind other forms. To give you the option to exercise some 

control of the form behavior the settings in the Form-Stay-On-Top 
preferences may be useful. By putting a checkmark in the box for the 

form the form will remain at the top position, even when it hasn't got the 
focus.  

 

Setting these preferences requires some experimenting... 
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4.14.5 description line format settings 

One of the strong features of SEQtools is the functions for customizing 
sequence listing to facilitate getting an overview of the sequences 
contained in the project. 

 
The four tabs included in Description Line Format settings are describes 

below. 
 

4.14.5.1 Format Settings - The check boxes on this tab enable/disable 
different formatting options. In addition it is possible to set a cutoff 

expect value to exclude blast results with worse than the specified match 

from the sequence list.  
 

The File menu includes save and load options for the selected formatting 
scheme to allow you to easily switch between different formatting 

schemes. Line formatting scheme files (*.lfs) are saved in the DataFiles 
folder of the main SEQtools application folder. A few *,lfs files are 

included in the setup file to illustrate how quite detailed line formatting 
can be accomplished with the different line formatting options. 

 

 
 
4.14.5.2 Left-Trim Lines - With this option you can enter a list of words 

to be removed from the start of the description lines. Removing occurs 
sequentially from the top of the list.  

 
Assume for example that a large number of the description lines have the 

word Rat as the first word hypothetical as the second word. Adding Rat as 
the first word in the list and hypothetical as the second will the remove 
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both words from the description lines. Whereas the two words in reverse 

order will remove nothing from such lines. 
 

In some cases you may want to remove everything from a specific 
character. This is possible by adding "<-" in front of the character from 

which you want to truncate the line. The"()" code removes the first word 
in brackets whereas "-()" removes only the brackets. Single characters 

can be removed by adding the character in leftmost column. 
 

 
 
4.14.5.3 Right-Trim Lines - This tab includes the same options as the 

Left-Trim Lines only the formatting occurs from the right end of the lines. 
 

 
 

4.14.5.4 Replace Lines - In many cases the best match of a blast 
search returns a description line indication that the match is to a 

hypothetical, putative, similar to, deduced or a probable protein. This is 

not very helpful if you are looking for an indication of a possible function 
of the protein.  
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By using the Replace Line filter you can make SEQtools skip description 

lines containing the forbidden words and instead look for alternatives 
further down the blast results - but still within the expect value cutoff set 

at the first tab of this form.  
 

If SEQtools is unable to find a description line without one of the 
forbidden words and within the expect value limit the first description line 

(=best match) is returned.  
 

 

4.14.6 chromatogram import settings 

The behavior of ConvertTrace is handled by SEQtools and do not require 
any user intervention. The format of trace files to be imported is 
automatically detected by SEQtools and passed on to ConvertTrace. 

ConvertTrace accepts most common trace file formats including ABI, ABD 

and SCF. 
 

The SEQtools interface to LifeTrace on the other hand gives the user 
extensive control over the basecalling process as well as of the removal of 

low quality regions from raw sequences. Read more about basecalling 
with LifeTrace under the File menu. 
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4.14.6.1 Fixed schemes - The SEQtools user interface to LifeTrace 

currently includes three fixed schemes for basecalling and trimming trace 
files (sloppy, standard and stringent), all based on: 

• - a minimum qscore value causing SEQtools to insert a N in the 

sequence instead of an ambiguous base 
• - the size of a sliding window in which none of the bases have 

qscore values below a given cutoff value  
• - the minimum accepted qscore in the sliding window  

• - a minimum gap quality score causing SEQtools to print the two 
bases flanking the gap in lower case characters. 
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4.14.6.2 Options for Basecalling - Setting optimal parameters for 

basecalling with LifeTrase is not trivial and may require some experiments 
before the best result is achieved. Useful hints are described below. 

 
The currently active parameters for basecalling and trimming are shown 

in a text box on the Preset Options tab. 
 

 

To compensate for differences in signal strength between individual 

sequence runs, an option is included to slightly modify the parameters 
compensating for varying signal strength among different trace files. With 

this function, Adaptive N-Threshold, enabled qscores are adjusted in the 
following way: 

 
QualityScore = QualityScore + ((MeanScore - NeutralMean) / 15). 

 
As can be seen from the equation above, this adjustment has no effect 

when the mean of all quality scores for the trace file is equal to the 
'neutral mean'. For mean scores greater than the 'neutral mean', quality 

score cutoffs are increased while score cutoffs smaller than the 'neutral 

mean' score are reduced. 
 

This option allows you to introduce a slight adjustment of the set 
parameters to compensate for small variations in the overall quality of 

individual trace files. 
 

This option as well as the quality scores, window sizes and gap quality 
scores currently selected for the three fixed settings may be adjusted if 

suggested by further testing of the function. 
 

4.14.6.3 Trimming Raw Sequences - Based on qscore values and a set 
sliding window length it is possible to perform a quite precise trimming of 

raw sequence files. Activate the adaptive N-threshold option to reduce the 
effect of varying peak height in the chromatograms. 
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4.14.6.4 N-Threshold - Options to control when the basecaller inserts 

an N when the basecalling is ambiguous. Activate the adaptive N-
threshold option to reduce the effect of varying peak height in the 

chromatograms 
 

 
 
4.14.6.5 Gap-Quality - Finally it is possible to have flanking, dubious 

bases displayed in lower case when the peak spacing is irregular 
(gap_qscore). This information is relevant to highlight regions where the 

number of bases within a short region of the sequence cannot be 
determined precisely. 



 259 

 

 

4.14.7 ncbi settings, firewall 

 

NCBI Ini-File - Using the various programs provided by NCBI require 
that a NCBI ini-file is present in the Windows folder. The ini-file contains 

the path to the NCBI data folder. Depending on your operation system, 
the name of the Windows folder is WINNT (Windows 2000) or Windows 

(Windows XP). This difference must be incorporated in the NCBI ini-file. In 
case you are behind a firewall you may also have to edit this information 

in the NCBI ini-file. 
 

The NCBI Ini-File editor include relevant information and options for these 
tasks. 
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4.14.8 internet connection and server settings 

4.14.8.1 Internet Connection - SEQtools verifies the internet 
connection each time the program is launched. This is done by connection 

to the Google server at the URL http://www.google.com/. It is possible to 
change this URL if you wish to test the connection to a different server. 

 

 
 

4.14.8.2 NCBI Resources - The NCBI Settings tab includes URLs to 
various NCBI resources. These values should not be changed by the user 

(unless you known exactly what you are doing). 
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4.14.9 compose search data file 

The default project restriction enzyme data file can be composed using 
the enzyme group editor shown below. The first tab includes a number of 
fixed patterns while the second tab allows you to create a highly specific 

enzyme file. 
 

After clicking Accept the selected enzyme file will be the default until it is 
changed. 
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4.14.10 log- and ini-file viewer 

Several log and data files are created by SEQtools or by the associated 
external programs. Often it is difficult to locate such files on your hard 

dish. This form includes links to all program generated text files. 
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4.14.11 application color coding 

It is possible to run parallel instances of SEQtools. This can make it quite 
confusing/difficult to identify to which instance a particular form belongs. 
With the Color Coding option you can choose an identification color for 

each instance of  SEQtools. This color is visible on most forms derived 
from the color coded instances.  
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4.15 HELP MENU 

1. 4.15.1  about seqtools help (general comments) 

2. 4.15.2  search for help on... 
3. 4.15.3  how to... 

4. 4.15.4  registration (entering registration information) 
5. 4.15.5  seqtools homepage 

6. 4.15.6  seqtools web manual 
7. 4.15.7  animated demos 

8. 4.15.8  seqtools configuration (updating program and external 
programs) 

9. 4.15.9  about seqtools 

10. 4.15.10  post bug report (news letters) 

4.15.1 about seqtools help 

The help menu includes various items related  registration, help options 
etc. 

 

 

4.15.2 search for help on... 

The index form of the context sensitive help. Press the <F1> key to 

access this help. In most cases the descriptions are fairly correct. And if 
not then try the web manual. If everything fails, you are always welcome 

to contact me at swr@seqtools.dk and I will try my best to solve your 
problem. Normally you can expect an answer within a few days - often 

the same day. 
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SEQtools context sensitive help form. 
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4.15.3 how to... 

The context sensitive help includes six short descriptions of how to 
perform various tasks in SEQtools. Unfortunately the descriptions have 
not been revised for a long time and may thus not be correct in all details. 

This problem will be handled at a later stage. 
 

 

4.15.4 registration 

The SEQtools form for entering registration information and a direct link 

to the website for getting a license agreement. 
 

 

This warning is issued before displaying the form for entering registration 

information. As stated in the message, be sure to save all project 
information before entering registration information. Incorrect information 

causes SEQtools to closed without further warnings when you click Accept 
or Exit. 

 

 

The form to enter registration information from your license agreement. 
Be sure to enter the information exactly as in the agreement. Both user 

name and the registration key are case and space sensitive. 



 267 

 

 

Message box displayed when incorrect information is entered in the form 

above and Accept is clicked. 
 

 

Message box displayed when incorrect information is entered in the form 
above and Exit is clicked. 

 

 

 

4.15.5 seqtools homepage 

Direct links to the SEQtools homepage, the SEQtools history page and to 
Frequently asked questions. 
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4.15.6 seqtools web manual 

Direct link to the web manual. 

4.15.7 animated demos 

My ambition has been for long time to write more animated demos. This 
may happen rainy day in the future... 

 

 

4.15.8 seqtools configuration 

This form lists currently available auxiliary programs, both NCBI and 
emboss programs as well as external programs (GeneDoc and TreeView). 

The same form is used if you need to update SEQtools or the auxiliary 
and emboss programs.  Finally the form includes a utility Data from old 

seqtools folders which causes SEQtools to scan your hard disk for data 

files from previous installations of SEQtools. 
 

When downloading and installing updates (SEQtools, auxiliary and emboss 
programs)  be sure to follow the instructions carefully. 
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4.15.9 about seqtools 

The SEQtools about form listing SEQtools version, user name and license 
type. For student licenses the number of days left of the license period is 

given as well as the version covered by the license. 
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4.15.10 post bug report 

The bug report form. It is a great help in correcting bugs that you give me 
as many details as possible,  preferably a precise description of how to 
reproduce the error. 

 
Often I receive descriptions like: "When I used SEQtools yesterday it 

behaved very strangely. Could you please have a look at this problem". 
Obviously this kind of descriptions makes it extremely difficult to localize 

a potential problem. 
 

Identifying hard-to-find problems may require that you send me the 

sequence giving rise to the misbehavior.  In such cases your sequences 
are deleted immediately after the problem is corrected to avoid 

confidentiality problems. 
 

In nearly all cases a bug, properly described, is corrected immediately 
and an updated version of SEQtools is made available on the download 

page of the web. 
 

At irregular intervals a newsletter is issued. This happens mostly when a 
serious bug is detected (and normally) corrected to give users a chance to 

update and thus avoid wasting time on a SEQtools version containing a 
known bug. 
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5. PRIMER PROJECTS 

1. 5.1  primer design 

1. 5.1.1    allowed characters 
2. 5.1.2    syntax check 

3. 5.1.3    primer and file name 
4. 5.1.4    how to design primers 

5. 5.1.5    functions 
6. 5.1.6    back-translate protein sequence 

2. 5.2  primer properties 
1. 5.2.1    melting temperature 

2. 5.2.2    calculation of Tm 

3. 5.2.3    primer properties 
3. 5.3  back-translate protein sequence 

1. 5.3.1    validation of sequence 
2. 5.3.2    codon usage tables 

3. 5.3.3    degeneration level 
4. 5.3.4    strand 

4. 5.4  primer header 
1. 5.4.1    primer file name 

2. 5.4.2    primer sequence information line 
3. 5.4.3    long primer name 

4. 5.4.4    chemical modifications of oligonucleotides 
5. 5.5  order primers by e-mail 

1. 5.5.1    primer order form 
2. 5.5.2    information retrieved from header 

3. 5.5.3    order text 

4. 5.5.4    save options 
5. 5.5.5    print options 

6. 5.5.6    view order file 
7. 5.5.7    sending order by e-mail 

8. 5.5.8    layout of e-mail order form 
6. 5.6  order form viewer 

1. 5.6.1    checksum verification 
7. 5.7  order preferences 

5.1 primer design 

This function File/Enter Sequences Manually/Primer Sequences is used to 
construct new primers for PCR amplification and DNA sequencing. When 

this option is selected the sequence export format is set to primer. Note 
that a new file must be created for each primer. The right mouse button 

activates a popup menu including common options for primer design. 

If a primer sequence is loaded as the FIRST sequence of a normal 

sequence project the project type is automatically set to primer design 
mode and subsequent files to be loaded must all be in primer format or 

be converted to this format. 
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Using SEQtools as a primer "database" including the primer sequences in 
a normal nucleotide project offers several advantages: The primer 

sequences can be annotated/verified by Genbank searching relevant 
databases. This annotation is stored in the sequence header of the primer 

sequence. You can then use sequence listing and searching facilities to 
identify for example primers for a particular organism, gene etc. 

  

 
 

5.1.1 Allowed characters 

Clicking the Format button, formats the primer sequence with a block 
length of 3 and a line length of 30. It also adds the symbols 

1. X = modified position 

2. I = Inosin 
3. ( = left parenthesis 

4. ) = right parenthesis 

as well as the IUB symbols for degenerate base positions to the list of 
valid characters. The position counter in the lower right of the editor 

window displays the actual number of bases in the primer - counting 

degenerate positions as one. 

5.1.2 Syntax check 

Degenerate base positions are either written in full or abbreviated by 
using IUB symbols. During formatting the primer sequence, syntax 

checking is performed. A warning which includes some common errors is 

issued if the primer sequence contains one or more of the following 
syntax errors. 
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1. - Empty brackets ( ) 

2. - Unpaired brackets ( ( 
3. - Identical bases in brackets (AA) 

4. - A single base in brackets (A) 
5. - 3' position is degenerate ACCTGT(ATG) 

5.1.3 Primer and file name 

The default name and extension of primer files is PRIMER.001 . The 
primer file names can be batch-changed with the file name template 

(Edit/Names/Edit Sequence Names) or change name functions. Specific, 
long primer names of up to 60 characters can be entered in the header 

form accessed from Header/Primer Header. If the user fails to enter a 
long primer name the primer file name is used instead. 

5.1.4 How to design primers - a brief description 

1. - Click File/Enter Sequences Manually/Primer Sequences to open a 
new project. 

2. - Enter the sequence of the primer in the empty file. 
3. - Click Update in the main editor to accept and format the 

sequence. 
4. - Right mouse button to open the popup menu and click Primer 

Properties to display the primer data. 
5. - On popup menu click IUB Symbols ON/OFF to toggle between 

normal and IUB symbols display. 
6. - Change the default file name PRIMER.001 to a unique file name in 

the main editor. 
7. - Click Header / Primer Header in the main editor to open the 

primer header. 

8. - In the primer header, enter the name of the primer, select 
modifications and user comments. 

9. - On popup menu click New Primer to create a new empty file for 
the next primer.  

- When finished, click File/Save or Export Files to store project. 

5.1.5 Functions, etc. 

Default format - The default primer formatting is line length of 30 

characters with blocks of 3. 

Copy and paste primers - Primer sequences can be pasted into an empty 
file from other applications including second instances of SEQtools. 

Convert to complementary strand - Click Edit/Crick Strand on the main 
editor form or on the popup menu to convert the primer sequence to its 

complement. 
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Primer properties - The primer properties can be displayed by clicking 

Analyze/Primer Properties on the main editor form or on the popup menu. 
If the primer includes degenerate positions the melting profile is 

calculated for the degenerate primer sequences with the lowest and the 
highest melting points. 

Degenerate positions - Degenerate positions in the primer sequence are 

either included in parentheses (IUB Symbols OFF) or typed using the IUB 
Symbols as illustrated by the two figures below: 

Degenerate positions by full base annotation: 

 

  

Degenerate positions by IUB symbols: 

 

5.1.6 Back translate protein sequence 

Click Translate / Back-Translate Peptide on the main editor menu to back-

translate an amino acid sequence into a degenerate primer. Before you 
can use this option you must type or copy/paste an amino acid sequence 

into an empty primer file. 
 

Also note that is necessary to select and load a codon usage file to 
provide relevant codon usage information for back-translation before this 

function can be used. You will be prompted to do so when you attempt to 
back-translate an amino acid sequence. SEQtools automatically prompts 

you to load either a *.cod (IUB format) or *.cut (seqtools format) file. 

5.2 primer properties 

This form Analysis/Primer Properties shows several characteristics of the 
current primer sequence including the number of bases, the GC 
percentage, the molecular weight, the A260 value and the Tm. 
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5.2.1 Melting temperature, Tm 

The melting temperature, Tm value is calculated according to the nearest-
neighbor method using the delta-H, delta-S and delta-G values from 
Breslauer et al. (1986). Proc. Natl. Acad. Sci. USA, 83, 3746-3750. 

If the sequence contains inosins, I, or modified positions, X, the mean 

delta-H, delta-S and delta-G values are used for the di-nucleotides 

including the I's or X's and the melting profile is displayed in red. For 
normal primers, the melting profile is shown in black. The melting profile 

is displayed graphically, averaged over four bases along the sequence. 

For primers with degenerate positions, the primer properties function 
determines the primer sequences with the smallest and largest Tm value 

and displays the two sequences with the minimum and maximum Tm for 
the degenerate primer sequence. An example is given below illustrating 

the function. 

5.2.2 Calculation of Tm value for the sample primer 

  
( A T G ) A G T G G C T T T T A G A A ( T G A ) ( T G A ) A G G ( T A 
G ) C T A A A ( A T C G )  

The calculation of the two Tm values for the lower and upper limit 
sequence is based on the following di-nucleotides ranked as: 

ranking = -deltaH/(-deltaS -13.909) 

DiBaseRanking( 1) = "TA" ' deltaH = 7.2 deltaS = 21.3 ranking = 0.204 
DiBaseRanking( 2) = "AT" ' deltaH = 7.2 deltaS = 20.4 ranking = 0.210 

DiBaseRanking( 3) = "AA" ' deltaH = 7.9 deltaS = 22.2 ranking = 0.219 
DiBaseRanking( 4) = "TT" ' deltaH = 7.9 deltaS = 22.2 ranking = 0.219 

DiBaseRanking( 5) = "AG" ' deltaH = 7.8 deltaS = 21.0 ranking = 0.223 
DiBaseRanking( 6) = "CT" ' deltaH = 7.8 deltaS = 21.0 ranking = 0.223 

DiBaseRanking( 7) = "GA" ' deltaH = 8.2 deltaS = 22.2 ranking = 0.227 
DiBaseRanking( 8) = "TC" ' deltaH = 8.2 deltaS = 22.2 ranking = 0.227 

DiBaseRanking( 9) = "AC" ' deltaH = 8.4 deltaS = 22.4 ranking = 0.231 
DiBaseRanking(10) = "GT" ' deltaH = 8.4 deltaS = 22.4 ranking = 0.231 

DiBaseRanking(11) = "CA" ' deltaH = 8.5 deltaS = 22.7 ranking = 0.232 
DiBaseRanking(12) = "TG" ' deltaH = 8.5 deltaS = 22.7 ranking = 0.232 

DiBaseRanking(13) = "CC" ' deltaH = 8.0 deltaS = 19.9 ranking = 0.237 
DiBaseRanking(14) = "GG" ' deltaH = 8.0 deltaS = 19.9 ranking = 0.237 

DiBaseRanking(15) = "GC" ' deltaH = 9.8 deltaS = 24.4 ranking = 0.256 

DiBaseRanking(16) = "CG" ' deltaH =10.6 deltaS = 27.2 ranking = 0.258 
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5.2.3 Primer properties for a primer with degenerate positions 

This form displays a number of parameters for the primer sequence. For 
primers with degenerate positions the parameters for the primer 
sequence with the highest and the lowest Tm value are calculated and 

displayed. Click the Refresh button to update the properties after editorial 
changes of the primer sequence. 

 

 
5.3 back-translate protein sequence 

This function Protein/Back-Translate Protein performs a back-translation 
of a peptide sequence into a degenerate DNA sequence and calculates the 
degree of degeneration. If the degeneration exceeds 10,000 times, the 

actual value is not displayed. 

5.3.1 Validation of sequence 

Be careful not to confuse a primer sequence written with IUB symbols and 
a peptide sequence. The program will issue a warning if the peptide 
sequence appears invalid (i.e., appears to be a DNA sequence including 

IUB symbols). 
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5.3.2 Codon usage tables 

Before back-translating an protein sequence a codon usage table must be 
loaded using the File menu on the codon usage form. SEQtools accepts 
two types of tables, either one generated and modified by the user *.cut 

or species specific codon usage tables imported in IUB format, *.cod. The 
latter type of tables can be converted to SEQtools format by simply by 

saving them with the *.cut extension whereas it is NOT possible to save 
codon usage files in IUB format *.cod.  

 
Seqtools prompts you to select and load a codon usage table when you 

try to back-translate a peptide sequence.  To accept the loaded codon 

usage table simply close the codon table editor after the table is 
successfully loaded into the editor. The selected table will be active until 

you change it by loading a new table (Analysis/Codon Usage). 

5.3.3 Degeneration level 

The degree of degeneration of primers created by back-translation can be 

controlled by selecting a degeneration level between 1 and 6, where 1 
implies that only the preferred codons are used for back translation (and 

the resulting primer is without degenerate positions). Choosing 
degeneration level 6 means that maximum degeneration is achieved and 

all possibilities are covered in the primer. Values between 1 and 6 uses 
the 2, 3, 4 or 5 most frequent codons for each amino acid. Obviously this 

will increase the degeneracy of the primer, only if more than one codons 
encodes a particular amino acid. 

5.3.4 Strand 

The peptide sequence can either be back-translated into a forward primer 
or a reverse primer. In the latter case, the back-translated sequence is 

converted into the complementary strand before the calculation of the 
degree of degeneration. 

5.4 primer header 

The primer header allows you to create and edit a sequence-specific 
header including various types of information related to the primer 

currently displayed in the editor. The entire content of the primer header 
including all field is attached to the header of the current primer when the 

file is saved. 
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5.4.1 Primer file name 

The primer file name can be edited manually in the main seqtools form 
and batch wise with the special functions for renaming files found under 
the Edit menu (Edit/Names/Edit Sequence Names). 

5.4.2 Primer sequence information line 

This line lists the file name, orientation of the sequence and the checksum 
of the displayed primer sequence. 

5.4.3 Long primer name 

The current file name for the sequence is displayed when the header form 
is opened. Long primer names up to 60 characters in length can be 

entered in this field and will be attached to the file header. The normal 
file/sequence name used for saving the sequences will remain unaffected 

by editing the long primer name. Note that you must unlock this field 
before the long primer name can be edited. The normal primer file/project 

name is local and will not be displayed in the primer ordering form. 

5.4.4 Chemical modifications of primers 

Four dropdown boxes are included in the primer header form to enable 
you to specify various 3' and 5' modifications, a preferred purification 
method and a user comment to your primer sequence. 
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Selecting a modification for either (or both) ends of the primer causes a 

field to be added to the header text: [3' MOD]= for 3' modifications and 
[5' MOD]= for 5' prime. The values of these fields are added to the primer 

order. The text can be selected from the dropdown lists, entered manually 
in the text field of the dropdown list or in the header text itself. Notice 

that the maximum length for all four manual entry types is limited to 40 
characters. Include here production related information relevant for the 

primer, e.g. purification method, coupling, origin, etc. 

5.5 order primers by e-mail 

This form includes facilities for constructing, saving, printing and e-

mailing primer order forms. Select the operations you want to perform 
and press Action. The selected save and print jobs will then be carried out 

sequentially. If the price per base in entered in the price text field, the 
order summary includes a price calculation for each length group of 

primers. Note that is not possible to e-mail the order before it is saved. 

5.5.1 Primer order form 

This form is used to compose the order form to be sent by e-mail to the 
oligonucleotide supplier. Before the form is usable the various standard 
information for the specified supplier must be entered in 

Preferences/Primer Ordering Settings as described in section 5.7. 
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5.5.2 Information retrieved from the header 

The primer export order function automatically retrieves the following 
information from the primer header: 

1. - Long primer name 
2. - 5' modifications of the primer ([5' MOD]= entry) 

3. - 3' modifications of the primer ([3' MOD]= entry) 

4. - The first 80 characters of header text (only if this option is 
selected in Order Text) 

5.5.3 Order text 

General information for the primer order is entered by clicking this button 
and filling in the necessary information if the different text fields. The 

Remarks text box includes three options for including sequence specific 
remarks. 

When order verification if on, the order text is verified and the user 

warned if information is missing or incorrect. Items in the verification list 
marked with a star should be checked before shipping the order. Turning 

verification off cancels this check. 

5.5.4 Save options 

This section of the export form contains three check boxes for selecting 
save items: 

1. - A normal primer order file, file extension: *.oof 

2. - An encoded primer order file, file extension: *.cof 
3. - A summary of the order, file extension: *.msg 

Click the check boxes for the operations you want to carry out and press 

the Action button. The selected save jobs will then be carried out 
sequentially.  

When any of the three check boxes are checked, the user is prompted for 
a file name for the primer order file. The name of the three files will be 

the same with the file-specific extensions added. If the file already exists, 
the user is warned before overwriting. 

Before the order files are saved, a sequence specific checksum is 

generated and saved with each primer sequence. The calculation of the 
checksum for the primer sequence is the same as that used by SEQtools 

for normal sequence but is done on the formatted sequence also taking 
spaces between blocks into account. 
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If the Encoded order file box is checked you will be prompted to enter - 

and reenter - the pincode of max 25 characters to be used by the 
encoding algorithm. Press <ENTER> after each entry of the pincode. In 

case the two entries differ, the user is warned and must re-enter the 
pincode. The same pincode is required for decoding the order file. Note 

that you cannot create an encrypted order file without first generating a 
normal order file. 

A simple XOR algorithm is used for encoding the order file which only 

provides limited protection against unauthorized access to the information 
contained in the file. Generally a long pincode (max 25 characters) makes 

the file more difficult to decode. Obviously the receiver must have access 

to the pincode used to encode the file. 

If a price per base in entered in the price text field, the order summary 
includes a price calculation for each length group of primers. 

The format of a normal order file is shown below. Note that each field of 

each record uses one line. Records are delimited by a /SOR/.../EOR/ pair. 
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5.5.5 Print options 

This section of the export form contains three check boxes for selecting 
print items: 

1. - The primer sequences 

2. - The complete, normal order file 

3. - A summary of the order 

Click the check boxes for the operations you want to carry out and press 
the Action button. The selected save jobs will then be carried out 

sequentially. The layout for the primer sequence print is shown below. 
The complete order file and the order summary are printed exactly as 

they are saved. 

5.5.6 View Order 

Clicking this command button displays the primer order viewer (Tools/File 
Tools/View Primer Order) which enables you to view both normal order 
files, encrypted order files and the mail.log file. Simply open the file you 

wish to view and follow the instructions on the form. You need to enter 
the pincode before an encrypted order file can be decoded and displayed. 

The order text is displayed exactly as it appears on the saved *.oof and 
*.cof. The decode function automatically saves a copy of the order file 

with the extension *.dof. 

5.5.7 Sending the order by e-mail 

When the order form is correctly filled out, the order can be sent 
automatically from SEQtools by clicking the Mail button. It is possible to 
enter a message to the supplier. 

5.5.8 Layout of the e-mail order form 

Each primer of an order file comprises a RECORD. Each record contains 
27 single-line text fields delimited by /SOR/ and /EOR/ as shown below. 

  

Start of user message 

            /SOM/ 

User message, inserted in front of order file if the file is sent by the e-mail 
function. This message is not included saved *.oof or *.ocf file. 

            /EOM/ 
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End of user message 

 
 Start of primer record 

/SOR/ 

[01 TITLE        ] Entered in order text as described above 
[02 FIRST NAME   ] Entered in order text 

[03 LAST NAME    ] Entered in order text 
[04 INSTITUTE    ] Entered in order text 

[05 DEPARTMENT   ] Entered in order text 
[06 LABORATORY   ] Entered in order text 

[07 COMPANY      ] Entered in order text 

[08 ADDRESS      ] Entered in order text 
[09 CITY         ] Entered in order text 

[10 COUNTRY      ] Entered in order text 
[11 ZIP CODE     ] Entered in order text 

[12 PHONE        ] Entered in order text 
[13 FAX          ] Entered in order text 

[14 E-MAIL       ] Entered in order text 
[15 CUSTOMER NO  ] Entered in order text 

[16 ORDER NO     ] Required, entered in order text 
[17 VAT NO       ] Entered in order text 

[18 DATE         ] Current system date 
[19 TYPE         ] From preferences/order text 

[20 SCALE        ] From preferences/order text 
[21 PURIFICATION ] From primer header or From preferences/order text 

[22 SHIPPING     ] From preferences/order text 

[23 5' MOD       ] From primer header, value of [5' MOD]= in header text 
[24 3' MOD       ] From primer header, value of [3' MOD]= in header text 

[25 PRIMER NAME  ] From primer header 
[26 USER COMMENT ] From primer header, value of [User comment]= 

[27 CHECKSUM     ] Check sum is recalculated by the decode function) 
[28 SEQUENCE     ] Sequence in upper case, block of 3, GCG symbols) 

/EOR/ 

End of primer record 

5.6 order form Viewer 

This utility (Tools/File Tools/View Primer Order) is used to decode 
encoded oligo primer orders *.cof and to view normal, un-encoded order 
files *.oof. To decode encoded order files, use the same pincode as was 

used when the order file was encoded. The file is marked read only and 
the text cannot be edited in this viewer. 

Use the page up and page down keys to navigate between individual 
records of the oligo primer order. The decoded file is automatically saved 
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in the directory from which is was loaded and gets the same name with 

the extension *.dof , (decoded oligo order file). 

5.6.1 Checksum verification 

After decoding the order file, all primer specific checksums are 
recalculated and the user notified if there are any discrepancies between 

the original and the recalculated checksums. 

 

 

5.7 order preferences 

The four tabs on this form (Preferences/Primer Ordering Settings) contain 
various text fields to customize the order text in the primer ordering form 

to fit the requirements of different suppliers. The content entered in the 
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text field serves as default values in the primer order text form.  

 
If for example the purification method has been specified in the header of 

a particular primer, this value overrides the default. The tabs include the 
following information: 
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6. PROJECT SEQUENCE LIST 

1. 6.1  about the project sequence list 

2.        6.1.1  excluding sequences from list 
3.        6.1.2  sorting the sequence list 

4.        6.1.3  selecting data source for sequences 
5.        6.1.4  searching the sequence list 

6.        6.1.5  customizing the displayed annotation 
7. 6.2  exporting the sequence list 

8.        6.2.1  export to new SEQtools instance 
9.        6.2.2  export to multi-sequence file 

10.        6.2.3  export to excel spreadsheet 

6.1 about the project sequence list 

The project sequence list is one of the key features of seqtools designed 
to assist you in maintaining an overview of the often large number of 
sequences included in a project. The list displays a single information line 

for each sequence of the project - or for a selected range of project 

sequences. 
 

The list form includes a number of options for customizing the list. You 
can exclude sequences from the list on the basis of the quality of blast 

search results so only sequences with a significant match (expect value) 
to a particular database at genbank are included in the list. 

 
The description lines returned from a genbank search can furthermore be 

formatted to remove irrelevant information - or information preventing a 
logical sorting of the description lines. The unformatted description is only 

a click away so you can easily check the original search result of the blast 
search.  

 
The various options included in the sequence listing form are described in 

the following sections of this page. The picture below shows how an fairly 

messy sequence list can be converted to a meaningful list of the positively 
classified project sequences. 
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Note that you always have the original blast search results at hand simply 
by highlighting a line and then holding down the right mouse button. This 

retrieves the blast section (shown below the list image) from the header 
for as long as you hold down the right mouse button. 

 

 

Once you have built the optimized sequence list the File menu includes 
several options for handling the included sequences in the optimized list. 

The options are fairly obvious, except perhaps the possibility of exporting 
the information to an Excel spreadsheet. Using this option requires that 

Excel is available either already installed on your PC or downloaded and 
installed as part of seqtools. Use the form shown below to select which 
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columns you wish to include in the spreadsheet file. 

 

 

6.1.1 excluding sequences from list 

There are a number of ways you can exclude project sequences from the 
list as shown on the unfolded Filter menu. You can hide sequences is they 

exists in more than one copy. The total number of copies is included 
duplicates in the Fmt column either as percent of all sequences in the 

project or as the actual number of copies of the sequence. Sequences 
with blast information as well as sequences where the blast expect value 

is outside the selected cutoff value.  

If; 

 

 

 



 289 

6.1.2 sorting the sequence list 

You can sort the sequence list by clicking the column caption for each 
column. Each click toggles between descending and ascending sorting. 
The only exception is the blast expect value, The program is written in the 

programming language Visual Basic which treats the content of each 
column as strings. This is fine for columns including textual information 

but not correct for the numerical expect values. I have not yet found a 
method to get around this minor problem so you have to live with this 

inconvenience. 
 

6.1.3 selecting data source for sequences 

Depending on the search data available for the sequences the View menu 
will contain a varying number of options. In the project used to illustrate 

this section of the help file only blastP data are at hand so the menu 
contains the plain sequence date option and the blast descriptions from 

the search. 

 
You use the Header Display Options form to compose the so-called virtual 

header which is simply a temporary header including the blast data you 
have decided to include. The form is shown below together with a form 

from a different project with more complete blast information available. 
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In this nucleotide project blast searches on the nr database have been 

conducted in addition to a blastX search from the complete protein 
database, tblastX on the yeast nucleotide database, and blastx searches 

on both D.melanogaster and E. coli translations. This project is the 
sample nucleotide project which can de downloaded from the seqtools 

website. 
 

 
 

Note that you need to select both the search data set and which part of 
the complete header information you wish to include in the virtual header. 

Look under the different tabs of the form to see the options. When you 
are done simply click Build Virtual Search to combine the selected 

information into the virtual header. Having built the virtual header you 
can choose to display the sequence list based on the information 

originating from each of the performed blast searches. 
 

 
 



 291 

6.1.4 searching the sequence list 

Pressing F3 displays the Search Descriptions search field which allows you 
to find entries in the sequence list. Note that the search starts from the 
beginning of the description line - and finds all occurrences of the query 

string. It is thus not possible to find a single word in the middle of a 
description line. 

 

Clicking the F3 key a second time changes the research target to all other 
fields of the sequence list. This function will probably be modified in the 

future to improve the search process.  

 

 
 

6.1.5 customizing the displayed annotation 

There are a number of ways you can format the description lines to 
facilitate sorting and viewing the sequence data. How to build the virtual 
sequence header has already been described above. It is important to 

realise, that this is a necessary operation before beginning optimizing the 
sequence list as this defines the data being available for the list. 
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The key form for formatting description lines is shown and explained 

below. The first tab includes general options for description line 
formatting such as switching on and off the two truncate functions and 

the line replacement function, adjusting upper/lower case display, 
neglecting the best blast match using the second best match instead,  a 

convenient options when search data originates from an local blast search 
where the best match is to the sequence itself. Also the blast expect value 

cutoff used in the sequence listing is set here. 
 

 
 
As shown in the examples below the description line returned from the 

database sometimes prevent proper sorting according to gene names. By 
removing the accession number and data base name from the beginning 

of the description lines solves this problem allowing you to perform a 
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meaningful alphabetic sorting of the descriptions. It is possible to perform 

line truncation either from the beginning or the end of the description 
line. 

 

 
 

In cases where the description line refers to a hypothetical protein, an 
unknown protein, a putative protein etc... you can create a replacement 

list which causes extraction of the description line from the blast section 
to skip lines including one of the listed words. The function scans all 

descriptions until it finds a description line within the cutoff limit that does 
not contain any of the forbidden words. If a meaningful description line is 

not found, the first - and best - match is returned. 
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You can save your description line processing preferences in a *lfs file so 
they can be used again. 

 
 

Below are two examples showing the top of a sequence list before and 
after left-truncating the description lines. The first showing the list before 

left-truncation has been performed. 
 

 
 
The description lines sorted alphabetically after left-truncation. 
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6.2 exporting the sequence list 

As indicated in the beginning of this section of the seqtools manual there 
are a number of options for exporting the information included in the 

sequence list. The options are briefly described below. 

If; 

 

 
 

6.2.1 export to new seqtools instance 

If you intend to continue working with the sequences included in the 
optimized list in seqtools, simply use this option to launch a new instance 

of seqtools which will contain all the sequences from your optimized list. 
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6.2.2 exporting to multi-sequence file 

The sequences included in the sequence list can be saved as a multi-sequence file which can 

be opened later in seqtools. The options available are evident from the image below. 

 

 

6.2.3 exporting to excel spreadsheet 

It has already been mentioned that the information included in the 
sequence list can be exported to an Excel spreadsheet. Note that you 

need to have Excel installed on your PC or to download and install the 
seqtools download file including excel.exe. 
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The options for selecting data for export to an Excel spreadsheet are as 
shown below. 
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Questions and Answers 

SEQtools includes several hundred functions and routines not all equally 

well documented in the context sensitive help and the web manual. On 
this page I have collected some questions (?) and answers (!) in no 

particular order. 

? How do I check if 
other sequences in my 

project are similar to the 
one I am current looking 

at?  

! Simply press F5 to perform a local 
BlastN or BlastP search on all 

sequences contained in the project. 
Click the result list to retrieve a 

match and shift-click to align the 
similar sequences with ClustalW.  

 
Remember to enter the correct 

parameters for the local blast 
function in project preferences.  

? When I run several 

instances of SEQtools 
simultaneously it is 

difficult to identify which 
forms that belong to the 

same instance.  

! You can color code individual 

instances of SEQtools, 
Preferences>Application Color 

Coding, to give each instance of 
SEQtools its own color.  

? My project includes 
2000 primer sequences. 

I wish to aliquot the 
primers in 96-well 

microtiter plates with 
defined positions left 

blank.  

! Use the microtiter plate indexing 
function, Special>Micro array Tools, 

to print sheets with the primer names 
precisely matching the microtiter 

plate. 
 

Place the plate over the template and 
read the primer names through the 

bottom of the plates. The template 
print function includes a utility to 

design the blank pattern.  

? The filenames of my 
sequences are not very 

logical. It is possible to 
re-name sequence files.  

! Yes. Seqtools has two functions for 
batch re-naming sequence files, 

Edit>Names>Edit Sequence Names. 
In addition it is possible to edit each 

filename separately.  
 

As SEQtools can load many files 
(more than 15,000 short est 
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sequences) careful validation of 

filenames takes place while loading to 
avoid duplicate filenames in the 

project  

? I have performed a 

batch blast search on all 
the sequences in my 

project. The search, 

however, failed for a few 
sequences. Do I have to 

repeat the search for 
each of these 

separately.  

! No. Open the sequence listing form, 

Sort the list according to description 
lines and highlight those with a "*No 

information" label. Open the ncbi 

blast form and find the Project 
settings tab. Check the checkbox to 

select the highlighted sequences. And 
start the blast search.  

? I need tools to 

perform clustering of my 
EST sequences.  

! SEQtools includes several clustering 

functions, Compare>Clustering. A 
'quick and dirty' overview function 

and three yielding detailed 

information on the sequence clusters.  

? I am planning a micro 

array based on 50-mer 
oligo nucleotides. Are 

there functions in 
SEQtools to assist me 

with this task.  

! Yes. New functions have been 

added to create index files for 
microtiter plates as well as for 

creating micro array layout. Look 
under Special functions. The 

functions for micro array design are 

closely integrated with the blast 
database search functions.  

? How do I customize 
SEQtools for my 

particular needs.  

! SEQtools includes seven 
Preferences forms each containing a 

number of options allowing you to 
customize the program in a number 

of ways.  

? Is it possible to export 
sequences from 

SEQtools in formats 
compatible with other 

programs.  

! Yes, you can export sequences in 
Genbank, Vector NTI, FastA, 

LaserGene, GCG Wisconsin, EMBL 
and as plain text. For FastA formats 

SEQtools includes an advanced editor 
for composing the definition line, 

Tools>Editors>FastA Definition Line 

Editor.  

? I have a list of 

accession numbers and 

! Use the conversion function: 

Tools>Conversion Functions>Convert 
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would like to get the 

corresponding genbank 
GI numbers.  

Genbank AC Numbers To GI List..."  

? I wish to edit my 
restriction enzyme data 

file. Is this possible in 
SEQtools.  

! Yes, SEQtools contains a separate 
editor which enables you to 

edit/add/remove individual entries in 
your enzyme data file, 

Tools>Editors>Search Data File 

Editor. It is possible to compose a 
sub enzyme data file containing only 

enzymes with selected characteristics 
such as: producing 5' overhangs, 3' 

overhangs, palindromic enzymes etc. 
Finally you can convert sequences 

contained in a SEQtools project into a 
sear data file.  

? My project contains 

400 human GPCR 
protein sequences and I 

would like to retrieve rat 
orthologs for the same 

genes.  

! Perform a batch BlastP search at 

NCBI on the nr database with the 
"rat" limiter. Use the Retrieve>New 

Project From Blast Results... function 
to create a new project including rat 

orthologs identified by the blastp 
search.  

? When I click "L" to 

display the sequence list 
and choose the view 

option "Description Line" 
the "Description" column 

is empty.  

! This is either because no blast 

results are available for the 
sequences - or because you have not 

composed a "Virtual Blast Section".  

? In the sequence list 

the rows are not sorted 

correctly when I click 
the "Expect" column.  

! The form used to display the list is 

unable to sort numerical values. 

Sorry...  

? How do I perform a 
batch blast search at 

NCBI.  

! Simply load the sequences you wish 
to search into a project. Then open 

the Search>Blast Batch Search select 
the method and set the necessary 

parameters and start the search. The 

search results are collected in the 
sequence headers.  

? I have very large ! Open the "Compose Header" form 
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sequence headers. How 

do I customize the 
displayed headers.  

by right-clicking the text header icon 

(an open book) and choose which 
sections you wish to include in the 

displayed header.  

? I need to construct a 

fasta multi-sequence file 
and want to include 

specific items from the 

sequence annotation in 
the definition line.  

! Use the fasta definition line editor 

Tools>Editors to compose the 
definition line.  

? I wish to convert a 
downloaded Locus Link 

search for "rattus map 
protein kinases" into a 

systematically organized 
file containing only 

certain items from the 

original list.   

! The multi-record text parser 
Special>Multi-Record Text File Parser 

does exactly this. Enter tags for the 
Record ID and for anchor for lines 

you wish to include in the converted 
file. Then use the same function in 

Line Mode to trim the extracted lines.  

carlsberg A/S terminates dnatols 

The owner of the copyright to dnatools, Carlsberg A/S, Copenhagen, 

decided to terminate supporting dnatools and requested me to hand over 

the source code as well as all additional information relating to dnatools 
when I left the company May 1. 2002. The note published by Carlsberg 

A/S specifically states that Carlsberg A/S do not wish to continue 
supporting dnatools and that they have no plans for further development 

of the program. 
 

Software for sequence analysis do, however, require continued 
maintenance to keep up with the dynamic evolution of this field. Since my 

departure from Carlsberg, NCBI, for example, terminated their support of 
the email-based blast search and information retrieval with Entrez which 

served as the basis of the automated sequence annotation functions, 
some of the very powerful features of dnatools. 

SEQtools 

I decided to take advantage of the experience I have achieved over the 
past six years from the work with dnatools to write a new software suite, 

SEQtools, for sequence analysis. 
 

As Carlsberg A/S requested me to hand over the source code to dnatools 
as well as my notes, backups etc., SEQtools has been written from 

scratch. This has been a major task which is not yet fully completed. The 
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program has, however, reached a state where I believe it may serve as a 

useful replacement for dnatools. 
 

I have enjoyed the pleasure of communicating with a large number of 
dnatools users around the world from whom I have received invaluable 

support, inspiration and help in improving the program over the years. In 
writing the new software package, SEQtools, I have drawn extensively on 

this information in trying to implement many of the proposals I have 
received from patient users. 
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